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I. Shimming the System to Specifications

Purpose: Obtain the “system shims” and store the maps

Sample needed: 1% CHCl3 in acetone d-6 “lineshape” sample

Instrument preparation: A deuterium gradient shim pulse width and calibration maps must be present.

Note that the pulse width and maps are measured by the JEOL service engineer at installation. These

maps and pulse width usually need not be re-measured.

Open Spectrometer Control -> Config -> Gradient Shim Tool. Click  and

. Set Iterations to 2. Select Z1-Z6 of the Shim Set. Click

. Click . The data acquisition should start. If you need

to stop the experiments from running, click Abort! (Figure 1). One can monitor the

Figure 1 Click Abort! to terminate gradient shimming events

Figure 2 The gradient image obtained during gradient shimming

progress of the experiments by looking at the View Tool. In the Processing menu of the

View Tool click Abs. The resulting image should eventually look something like Figure

2. To help judge whether the shims are converging, look at the residual window. The



ECLIPSE+ NMR Training Guide, v4.3.4

6

residual window displays both the changes in the shims and the changes in the residual.

Figure 3 shows a typical result. When the shimming process completes, relock the

sample. Turn off the spinner and shim the non-spin shims. You can shim in the order

given in the Shim Groups portion of the Sample Tool (Figure 4), or use the abbreviated

procedure given in Appendix A. If there are significant changes made to the non-spin

shims, rerun gradient shimming. Otherwise, turn the spinner back on and optimize the

Lock Phase (Figure 5) by adjusting to get the maximum lock signal. To verify that the

shims are optimized you need to run the Lineshape Test.

Figure 3 The gradient shimming residual window (3 iterations)

Figure 4 Click on the double-arrow to change the shims visible in the Sample Tool

Figure 5 Adjust lock Phase in the Lock Control section of the Sample Tool
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Lineshape Test

Purpose: Determine if the shims are within specifications, if acceptable save the shims

Sample needed: 1% CHCl3 in acetone d-6, “lineshape sample”

Instrument preparation: A very well shimmed system.

Experiment used for test: /usr/delta/global/experiments/service/1h_lineshape.exp

Process list used for test: dc_balance, fft

Set recvr_gain to a value that does not result in clipping. The T1’s of the chloroform

proton are on the order of 50[s], so auto_gain can give poor results. Moreover, it is

important that the spins be fully relaxed to obtain an accurate result in this test. Run the

experiment on your well-shimmed sample. Using the Zoom data  function of the

pointer tool, zoom and inspect the main peak. This peak should be symmetric and should

not be split near the top. If it is split at the top, you may need to touch up Z1. Next, the

width of the peak needs to be measured. Because the shape of an NMR signal can vary

widely with shimming, the peak widths in this test are measured relative to the 13C

satellites. Zoom the peak so the 13C satellites are visible. In acetone, they should be about

210[Hz] apart. With the cursors function of the pointer tool, use Create cursor  to

place a cursor at the height of the 13C satellites, and then one at one-fifth that height

(Figure 6). One can estimate these values given the intensity (!I) displayed by the cursor.

If the satellites happen to be at different intensities, choose the one of lower intensity.

Now, zoom the main peak (you can get Zoom data back temporarily by holding down the

Shift key) and using Create Measure , measure the width of the main peak where it

intersects the height of the 13C satellites. Take note of this value. Now measure the width

at one-fifth the height of the 13C satellites. If the lineshape specification is met, you

should save the shims as the “system shims”. Select Spectrometer Control -> Tools ->

Mode -> Console. Type console into the box that appears. You should notice that the

connection in Spectrometer Control changes from Connect to Console. In the Sample

Tool make sure , which is the System Shims toggle, is depressed. Click on

, which is the save shims to disk icon. Respond to the confirmation window. A

message verifying that you saved the system shims will be reported in the Master

Console.
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Figure 6 Placing cursors at the height of the 13C satellites, and at one-fifth that height
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Figure 7 Determining the peak width using Measure.



ECLIPSE+ NMR Training Guide, v4.3.4

10

II. Saving Pulse Widths with Machine Config?

You can access this GUI tool in Spectrometer Control by first logging in as console. You

need to choose Tools-> Mode-> Console and to type the console password into the box

that appears. Press Enter. After a few moments, you will notice the mode will change

from "Connect:" to "Console:" and the field containing this text will change color. Now,

if you choose the Tools menu, you will have more choices, including Machine Config? .

Choose this option. The box in Figure 8 will appear. Choose the probe file you wish to

Figure 8 Graphical method for editing files on the acquisition computer

Figure 9 Example of a probe file in Machine Config?

edit. Note that the probe number for the currently installed probe is indicated in the

Sample Tool as the Probe ID. Click Edit. Another box will appear (Figure 9). With this

tool, you can edit a particular pulse width by clicking on it, highlighting its numerical

value and then re-typing it. If you want to save the change(s) you made, click on Save

and then Close. If you make a mistake, you can click on Undo. Each of the subsequent

pulse calibration sections indicates where to change the values in this tool. To save pulse

widths via command line, open a UNIX shell. Perform an rlogin to the acquisition

computer and edit the appropriate file in: /eclipse/probes/. The three entries listed

correspond to the full-power obs 90, high-power decoupling 90 and low-power

decoupling 90, respectively, for a given domain.
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1H Obs 90

Purpose: Determine the proton observe 90° pulse width

Sample needed: 5% CHCl3 with Cr(acac)3 in acetone d-6

Instrument preparation: Shim and tune probe to the sample (1H).

Experiment used: /usr/delta/global/experiments/service/obs90_check.exp

/usr/delta/global/experiments/service/obs90_array.exp

Process list used: /usr/delta/global/process_lists/std_proton.list

A survey spectrum needs to be collected first to get the exact position of the CHCl3 peak

and a receiver gain value. Using obs90_check.exp, run an experiment with auto_gain

checked. Also, click force_tune to allow probe tuning. Click on Submit to initiate the

experiment and note the gain value reported in the Master Console. You will enter this

receiver gain value into the box for recvr_gain in obs90_array.exp. When the data from

obs90_check.exp returns, process the data and zoom the chloroform peak. With the Copy

position of nearest peak tool , click on the center of the chloroform peak (Figure 10).

This will store the peak position in a cut/paste buffer. Move the mouse into the x_offset

field in obs90_array.exp, double-click the right mouse button to clear the present offset

value and then click the middle mouse button to paste the new offset value. Enter the

receiver gain noted previously from the Master Console into the recvr_gain field.

Arrayed experiments will not run with auto_gain checked. Submit the arrayed

experiment. When the acquisition finishes, the data will be returned in an nD Processor.

Click on the  button. A 1D processor will open with the first slice of the data set.

Process and manually phase the data set using the buttons for p0 and p1 or click on ,

which is the autophase button. When phasing is complete, close the 1D processor. You

will notice an updated processing list in the nD processor, which will include your phase

correction values. These values will be applied to each slice of the data. Now click ,

which will process the data and display it in a Data Slate (Figure 11). The data in the data

slate will be displayed in “image mode”. Image mode displays the data as if you were

looking down on top of the data, stacked side-by-side. The y-axis in this case is time (µs)

and the x-axis is in ppm. Zoom the stripe centered around 8 ppm. Now using Pick

position  (not Copy position of nearest peak ), click on the image view

representation at the exact position you put the x_offset. A curve will be generated from

the maxima and minima of the peak intensities. Now click on Expansion -> Linearize.

This will display the data from head to tail. Determine the best 360º null either from the

sinusoidal curve or from the head-to-tail view. After determining what the value in µs is

for the null, divide by four to get the 1H obs 90 pulse width. If you did not reach a 360,

modify the array settings in the x_90_width field and rerun the experiment. For display

purposes, one can remove all but the curve and head-to-tail views. Move the mouse on

top of a view to be removed. Hit the PageUp key on the keyboard to select the view.

Notice that the mouse pointer will be colored yellow when passed over the active pane.

Click on  to remove the view. Figure 12 shows a typical 1H Obs 90 pulse width result.
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Figure 13 highlights where to save your pulse width and attenuator values in Tools ->

Machine Config?.

1.

Figure 10 Finding the x offset for the 1H Obs 90 determination
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Figure 11 Image mode representation of data

Figure 12 1H Obs 90 pulse width
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Figure 13 Change the highlighted value to save the 1H Obs 90 pulse width

*
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13C Obs 90

Purpose: Determine the carbon observe 90° pulse width

Sample needed: 50% CHCl3 with Cr(acac)3 in acetone d-6

Instrument preparation: Shim and tune probe to the sample (13C) and (1H).

Experiment used: /usr/delta/global/experiments/single_pulse_dec.exp

Process list used: /usr/delta/global/process_lists/std_carbon.list

A survey spectrum needs to be collected first to get the exact position of the CHCl3 peak

and a receiver gain value. In single_pulse_dec.exp, run an experiment with auto_gain

checked. Also change scans to 1, x_prescans to 0 and x_angle to 90[deg]. Click on

Submit to initiate the experiment and note the gain value reported in the Delta Console.

When the experiment returns and finishes processing, zoom the chloroform peak. With

the Copy position of nearest peak tool , choose the main of the peak at ~78[ppm]

(Figure 14). Paste this value into the x_offset field in single_pulse_dec.exp. Also enter

2.Figure 14 Finding the x offset for the 
13

C Obs 90 determination

Figure 14 Finding the x offset for the 13C Obs 90 determination

the receiver gain value previously noted into the box for recvr_gain. Uncheck auto_gain.

Click on  to open an array box. Click Y to indicate a pseudo second
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dimension, uncheck Listed, and then enter start, stop and step values of 2, 50 and 2 [us],

respectively (Figure 15). Click Set Value. Set relaxation_delay to 20[s]. Submit the

experiment. Process the arrayed data, as in the 1H Obs 90 determination and determine

the best 360º null. If you did not reach a 360, modify the array settings in the x_90_width

field and rerun the experiment. Figure 16 shows a typical result. Figure 17 highlights

where to save your pulse width and attenuator values in Machine Config?.

Figure 15 Arraying x_90_width
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Figure 16 13C Obs 90 pulse width

Figure 17 Change the highlighted value to save the 13C Obs 90 pulse width

*
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1H Decoupling 90

Purpose: Determine the proton decoupling 90° pulse width

Sample needed: 50% CHCl3 with Cr(acac)3 in acetone d-6

Instrument preparation: Shim and tune probe to the sample (13C, 1H)

Experiment used: /usr/delta/global/experiments/service/irr90_check.exp

Process list used: /usr/delta/global/process_lists/std_carbon.list

Copy the x_offset value used in the 13C obs 90 pulse width determination into x_offset

and the x_offset value used in the 1H obs 90 pulse width determination into irr_offset.

Enter a value of 1[us] for irr_pulse but remember the current pulse width. Click

auto_gain. Submit the experiment. Enter the current pulse width into irr_pulse, and the

receiver gain determined from the first experiment into recvr_gain. Uncheck auto_gain.

Submit the experiment. Process the 1[us] data so that the peaks at ~78[ppm] are anti-

phase. Phase the data either manually or with autophase and apply the phase conditions to

the process list. Hit Process. Using drag-and-drop, transfer this processing list to the data

from the second experiment. The pulse width is a 90 when the two peaks are nulled. If

the two peaks still have intensity with the same phase as the 1[us] data, the pulse width is

too short. If the peaks flip over, the pulse width is too long. Figure 18 shows a typical

result. If you are happy with the result save the pulse width in Machine Config?.

Otherwise, run single experiments until you find a good pulse width value. Figure 19

highlights where to save your pulse width value in Machine Config?.

Figure 18 1H Decoupling 90 Pulse width, (top) 1[us] data, (bottom) irr_pulse with a well calibrated 90
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Figure 19 Change the highlighted value to save the 1H Decoupling 90 pulse width

*
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DEPT 90 Check

Purpose: Verify that the proton decoupling 90° pulse width is correct

Sample needed: 10% ethylbenzene in chloroform-d

Instrument preparation: Shim and tune probe to the sample (13C, 1H)

Experiment used: /usr/delta/global/experiments/service/dept_cal.exp

Process list used: /usr/delta/global/process_lists/std_carbon.list

Change selection_angle to 90. Set recvr_gain to an appropriate value. Submit the

experiment. If the 1H decoupling 90 pulse width is correct, one should only see the three

aromatic carbon peaks. Figure 20 shows a result of a properly calibrated pulse width.

Figure 20 DEPT 90 Check for a Well-Calibrated 1H Decoupling 90
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13C Inverse 90 and Decoupling 90

Purpose: Determine the carbon inverse 90°and decoupling 90° pulse width

Sample needed: 5% CHCl3 with Cr(acac)3 in acetone d-6

Instrument preparation: Shim and tune probe to the sample (13C, 1H)

Experiment used:

/usr/delta/global/experiments/1d_inverse/hmqc_irr_check.exp

/usr/delta/global/experiments/1d_inverse/hmqc_irr_dec_check.exp

Process list used: /usr/delta/global/process_lists/std_proton.list

Copy the x_offset value used in the 1H obs 90 pulse width determination into x_offset

and the x_offset value used in the 13C obs 90 pulse width determination into irr_offset.

Enter a value of 1[us] for irr_pulse but remember the current pulse width. Click

auto_gain. Submit the experiment. Enter the current pulse width into irr_pulse, and the

receiver gain from the first experiment into recvr_gain. Uncheck auto_gain. Submit the

experiment. Process the 1[us] data so that the main peak is ~90° out of phase. This will

result in the satellites, which are the peaks of interest, being anti-phase. Apply the phase

conditions to the process list. Click Process. Using drag-and-drop, transfer this

processing list to the data from the second experiment. Click Process. Zoom the two data

sets identically. Note that it is possible to drag x and y limits when the Zoom data cursor

is selected. The pulse width is a 90 when the two small peaks are nulled. If the peaks still

have intensity with the same phase as the 1[us] data, the pulse width is too short. If the

peaks flip over, the pulse width is too long. Figure 21 shows a typical result. If you are

happy with the result save the pulse width in Machine Config?. Otherwise, run single

experiments until you find a good pulse width value. Figure 22 highlights where to save

your 13C Inverse 90 Pulse width in Machine Config?. To find the decoupling pulse

width, use the same procedure except use hmqc_irr_dec_check.exp. Figure 23 shows

where to save your 13C Decoupling 90 Pulse width in Machine Config?.
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Figure 21 13C Inverse 90 Pulse width, (left) 1[us] data, (right) a well-calibrated 90

Figure 22 Change the highlighted value to save the 13C Inverse 90 pulse width

Figure 23 Change the highlighted value to save the 13C Decoupling 90 pulse width

*

*
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Selective 90

Purpose: Calibrate the selective 90 degree pulse width.

Sample needed: 5% CHCl3 in acetone d-6 doped with trace Cr(acac)3

Instrument preparation: A well-shimmed system with the probe tuned to the sample (1H).

Experiments used in this calibration:

/usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/service/20dB_att/obs90_w_20dB_att.exp

This pulse width is necessary for the dpfgse_noe_pfg_s.exp. A survey spectrum on

proton needs to be run first. Run the survey spectrum using single_pulse.exp. Transfer

the receiver gain value to recvr_gain and the on resonance condition for the CHCl3 peak

to x_offset, in obs90_w_20dB_att.exp. Set obs_attenuator to 40[dB]. Set auto_dwell to

false as in the spin-lock 90 calibration. Array x_pulse from 2-50[ms] with a step size of

2[ms]. When the data set returns, process it as in the 1H obs 90 pulse width calibration.

You are looking for the best null. Divide the null by two to get your pulse width. Save the

pulse width and attenuator value in the dpfgse_noe_pfg_s.exp itself.

Note: The optimum pulse width is highly dependent on the amount of bandwidth you

require. Recall that the B1 field can be calculated by: B1(Hz) = 1/(4*pulse width [s]). One

can conveniently double the effective bandwidth by halving the selective 90 pulse width

and lowering the obs_attenuator value by 6[dB].
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Figure 24 1H Selective 90 pulse width
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1H Spin-lock 90

Purpose: Calibrate the spin-lock 90 pulse and spin lock attenuator.

Sample needed: 5% CHCl3 in acetone d-6 doped with trace Cr(acac)3

Instrument preparation: A well-shimmed system with the probe tuned to the sample (1H).

Some experiments using this pulse: tocsy_pfg_s.exp

Experiments used in this calibration:

/usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/service/spin_lock90_check.exp

A proton survey spectrum needs to be run first. Run the survey spectrum using

single_pulse.exp. Transfer both the receiver gain value noted from the Delta Console and

the on resonance condition for the CHCl3 peak to the appropriate fields in

spin_lock90_check.exp. Transfer the on resonance condition to x_offset. Set x_pulse to

twice what you feel is suitable for covering the desired bandwidth. Recall that the B1 field

can be calculated by: B1(Hz) = 1/(4*pulse width [s]). Thus, for a 4 kHz field on a

300MHz spectrometer, you would need a pulse width of about 62.5 µs. Array

obs_attenuator from 15-30[dB] in steps of 1[dB]. When the data set returns, process it as

in the 1H obs 90 pulse width calibration. Look for the best null. Transfer the attenuator

value that gave the best null to obs_attenuator. In the Header section of

spin_lock90_check.exp, click on Header. This will bring up a window allowing you to

change the flags in the Header section. Click on auto_dwell. Then click on Add and then

Done. The experiment window should recompile and display the auto_dwell flag. Make

this flag false by un-checking the box. Now, array x_pulse centered around twice the

desired pulse width value. When the arrayed data set returns, process it as in the 1H obs

90 pulse width calibration (Figure 25). Divide the null value by two to get your pulse

width. Note the pulse width and attenuator value. Figures 26 and 27 illustrate where to

change these values in the graphical tool.



ECLIPSE+ NMR Training Guide, v4.3.4

26

Figure 25 Spin-Lock 90 pulse width

Figure 26 Change the highlighted values to save the Spin-Lock 90 pulse width

Figure 27 Change the highlighted values to save the Spin-Lock 90 attenuator

*

*
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19F Obs 90

Purpose: Determine the 19F observe 90° pulse width

Sample needed: 0.05% trifluorotoluene in benzene-d6

Instrument preparation: Shim and tune probe to the sample (19F).

Experiment used: /usr/delta/global/experiments/service/obs90_check.exp

/usr/delta/global/experiments/service/obs90_array.exp

Process list used: /usr/delta/global/process_lists/std_proton.list

A survey spectrum needs to be collected first to get the exact position of the fluorine

peak. Set x_domain to Fluorine19. Set recvr_gain to an appropriate value. Set x_offset to

–62[ppm] and x_sweep to 100[ppm]. Submit the experiment. Copy the x-position of the
19F peak and paste it into x_offset in obs_90_array.exp. Set relaxation_delay to 15[s].

Submit the experiment. Process the data and find your best null. Divide the null by two to

get the 19F obs 90. Figure 28 shows a typical result. Figure 29 highlights where to save

your pulse width in Machine Config?.

Figure 28 19F Obs 90 pulse width
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Figure 29 Change the highlighted value to save the 19F Obs 90 pulse width

*



ECA/ECX NMR Training Guide, v4.3-a

29

31P Obs 90

Purpose: Determine the 31P observe 90° pulse width

Sample needed: 1% trimethylphosphite in acetone-d6

Instrument preparation: Shim and tune probe to the sample (31P, 1H)

Experiment used: /usr/delta/global/experiments/service/single_pulse_dec.exp

Process list used: /usr/delta/global/process_lists/std_carbon.list

A survey spectrum needs to be collected first to get the exact position of the phosphorus

peak. Set x_domain to Phosphorus31. Set recvr_gain to an appropriate value. Set

x_offset to 140[ppm] and x_sweep to 200[ppm]. Set scans to 1, x_prescans to 0 and

x_angle to 90[deg]. Submit the experiment. Copy the x-position of the 31P peak and paste

it into x_offset. Array x_90_width from 2-50[us] in 2[us] steps. Set relaxation_delay to

30[s]. Submit the experiment. Process the data and find your best null. Divide the null by

four to get the 31P obs 90. Figure 30 shows a typical result. Figure 31 highlights where to

save your pulse width in Machine Config?.

Figure 30 31P Obs 90 pulse width
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Figure 31 Change the highlighted values to save the 31P Obs 90 pulse width

*
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15N Obs 90

Purpose: Determine the 15N observe 90° pulse width

Sample needed: 90% formamide in dmso-d6

Instrument preparation: Shim and tune probe to the sample (15N, 1H)

Experiment used: /usr/delta/global/experiments/service/single_pulse_dec.exp

Process list used: /usr/delta/global/process_lists/std_carbon.list

A survey spectrum needs to be collected first to get the exact position of the nitrogen

peak. Set x_domain to Nitrogen15. Set recvr_gain to an appropriate value. Set x_offset

to 108[ppm] and x_sweep to 200[ppm]. Set scans to 1, x_prescans to 0 and x_angle to

90[deg]. Submit the experiment. Copy the x-position of the 15N peak and paste it into

x_offset. Array x_90_width from 2-50[us] in 2[us] steps. Set relaxation_delay to 160[s].

Submit the experiment. Process the data and find your best null. Divide the null by two to

get the 15N obs 90. Figure 32 shows a typical result. Figure 33 highlights where to save

your pulse width Machine Config?.

Figure 32 15N Obs 90 pulse width
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Figure 33 Change the highlighted values to save the 15N Obs 90 pulse width

*
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III. Commonly Used Experiments in Structure Elucidations

The following sections describe how to perform some commonly used NMR experiments

using the DELTA software. All the data in these descriptions were collected on a sample

of quinidine in CDCl3. A numbering scheme and structure for quinidine is shown in

Figure 34. All of the subsequent discussions and figures will refer to this scheme.

N

OCH3
H

OH

N

CH2

H H

Figure 34 Structure and numbering scheme for quinidine
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1D Proton

Purpose: Collect a 1D proton data set

Experiment(s): /usr/delta/global/experiments/single_pulse.exp

Pulse width(s) used: 1H Obs 90

Processing List(s): /usr/delta/global/process_lists/std_proton_autophase.list

A 1D proton NMR spectrum is normally the first experiment run on a sample. A proton

spectrum yields a wealth of information including: total number of protons present (from

integrations), the basic types of protons present (from chemical shift) and proton

connectivities (from coupling constants and splitting patterns).

Parameters to set

Check auto_gain to automatically find the best receiver gain value. A correctly set

receiver gain will avoid “clipping” the data. Set scans to the number desired.

Processing

Load or assemble an appropriate processing list and then peak-pick and integrate the data.

Loading a Processing List

In 1D Processor, it is possible to build processing lists from the various menus or to load

a list from disk. Click , which is near the  button, to open a standard list

from disk. The box in Figure 35 will appear. Click  to change to the global

directory. Choose std_proton_autophase.list and then click OK. A processing list

will appear. Click Process to execute the processing list. Touch up the phase with P0 and

P1 if necessary. Alternatively, one can load a proton processing list by clicking on ,

located in the row of macro icons in 1D Processor.
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Figure 35 Choosing a process list from disk, the “global” button is indicated by the red box

Using the Pointer Tool to Manipulate Data

To manipulate data graphically, the Pointer Tool appears on both 1D and 2D data. The

tool is divided into 13 modes. By default, Zoom mode appears the first time you open a

1D Processor. Every time thereafter, the last-used tool will appear in data windows. By

clicking where it says Zoom with the left-mouse button, you will be able to select any of

the other remaining major modes. Using these modes, one can peak pick, integrate and

Figure 36 The Zoom mode of the Cursor Tool

Figure 37 The fourteen available modes in the Cursor Tool
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add text annotation, to name but a few functions. Each of the major modes has unique

features, including hot key functions, which are available only when a particular major

mode is selected. To view the hot keys available for the presently selected mode, select

. Figure 38 shows the available hot keys for Zoom. Moreover, there are three Zoom

Figure 38 The hot keys available from the Zoom cursor

hot keys which are particularly useful. These three hot keys are: Home, which resets both

axes to the original limits, Backspace, which will step back to previous zooms, one zoom

at a time, and End, which will scale the data in the y-dimension to fill the screen. Finally,

it should be noted that from whatever major mode you are in, one can always get Zoom

data by holding down the Shift key.

Using the Peak Mode of the Pointer Tool

The “automatic” peak picking in a 1D data set is done with regards to peak pick

thresholds. There are three threshold lines drawn on data. The positive peak threshold is

drawn in green, while the noise threshold and negative peak threshold are drawn in gray

and red, respectively. The Peak mode of the pointer tool contains tools to adjust these

thresholds. Since there are many buttons in this mode, it may initially be difficult to

remember what the icons mean. One can view what all the buttons in any particular major

mode correspond to by clicking the middle mouse button on the name of the tool (i.e. in

this case, middle-click where it says Peak). It should be noted that most of the NMR

systems are shipped with mice that have a wheel for the middle mouse button. Pressing

on the wheel is equivalent to pressing a middle mouse button. If you click the middle

mouse button in Peak mode, you will see the menu in Figure 39. It is possible to select

the sub-modes within this menu using the mouse. To adjust the positive peak-picking

threshold, choose Adjust peak threshold. Move the green line so that the tops of all the

desired peaks are above the threshold. Click , which is located in the top row of
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Figure 39 The sub-modes seen in Peak by pressing the middle mouse button

icons, to peak pick the data set. An example showing the peak pick threshold is given in

Figure 40.The threshold can be re-positioned if desired but the peak picks will not be re-

picked until you click  again. With peak-picked data, it is possible to use one of the

Peak mode hot keys to help elucidate coupling constants. Select two peaks of interest

with Select more peaks. Now hit the letter j on the keyboard. The frequency difference

between these peaks, in Hz, will be displayed on the data. Additionally, a new peak-pick

will appear at the center of the two selected peaks. This centroid peak can be used to

identify a peak position or for nesting additional coupling information. To generate

additional “J’s” be sure to unselect the currently selected peaks with Unselect peaks or

by hitting the letter u on the keyboard. The difference algorithm will always give the

frequency difference between the two outer-most selected peaks. Figure 41 shows an

example of the J Coupling feature.

Figure 40 Setting the positive peak threshold in Peak mode

Positive peak

threshold line
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Figure 41 The result of the J Coupling feature in Peak mode (see values above the data)

Using the Integral Mode of the Pointer Tool

The integration in a 1D data set can be done automatically by clicking  (located in the

top row of icons of 1D Processor). However, it is common to integrate data manually. To

integrate data manually, choose , which is Create integral, while in Integral mode.

Remember to middle-click on the name of the tool (in this case Integral) if you are

unsure of the identity of a particular sub-mode’s icon. An integral is created by choosing

a start and stop point about a peak or group of peaks. The start and stop points are

indicated by two small blue boxes drawn on the data. To generate a start and stop point,

single-click-hold the left mouse button in the gray area underneath the x-axis of the data

(Figure 42). You will see a blue box drawn on the data. Drag across to the desired

stopping point and then release the mouse button. Notice that by keeping the mouse focus

in the “gray area” below the x-axis forces the blue boxes to be drawn on data points (i.e.

along the baseline). Therefore, drawing integrals while in the gray area is the best way to

get nicely drawn integrals. Should an integral need to be adjusted, use the sub-modes

Change slope of integral or Adjust integral.
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Figure 42 Be sure to stay in the gray area when drawing an integral with Create integral

Plotting Data

To plot a data set click , located in the top row of icons. The resulting hardcopy will

be WYSIWYG (what-you-see-is-what-you-get).

Assignment Strategy

In quinidine, we know that there are 24 protons, therefore, we must integrate at least this

many protons in our proton spectrum to have a correct structure. If there are “additional”

protons, one might look for solvent or starting material resonances. With some prior basic

chemical shift information, one can confirm that there are correct numbers of aromatic

and aliphatic protons, and that the alcohol, methoxy and vinyl protons are present. Note

that it is possible for exchangeable protons, such as alcohol protons, to be “absent” in a

proton spectrum. If such protons are present, they may not integrate to an integer value.

Some “obvious” assignments are given in Figure 43.

Click-hold-drag

Put Mouse Focus in Here When Drawing Integrals
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Figure 43 A 1D proton spectrum of quinidine
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1D Carbon and DEPT 135

Purpose: Identify the number and types of carbons present

Experiments: /usr/delta/global/experiments/single_pulse_dec.exp and dept.exp

Pulse width(s) used: 13C Obs 90, 1H Decoupling 90

Processing List(s): /usr/delta/global/process_lists/std_carbon_autophase.list

A 1D carbon is normally run on organic samples. A carbon spectrum gives information

about the number and type of carbons (from chemical shift) that are present in the

sample. To confirm the types of carbons present, one can also run a DEPT 135

(Distortionless Enhancement by Polarization Transfer) experiment. The DEPT

experiment yields different phases for CH’s and CH3’s versus CH2‘s, which allows for

their discrimination. Also, because quaternary carbons do not appear in a DEPT, signals

that may be hidden under residual solvent resonances are readily revealed. Finally,

because the DEPT experiment utilizes a polarization transfer to increase signal intensity,

it usually requires fewer scans than a carbon to achieve a comparable signal-to-noise.

Parameters to set

Check auto_gain in both experiments to automatically find the best receiver gain values.

A correctly set receiver gain will avoid “clipping” the data. Set scans to the number

desired. In the DEPT experiment, set selection_angle to 135[deg]. Additionally, to

maximize available NMR time, these experiments can be set to run to a particular signal-

to-noise value. To do this, enter a non-zero value into sn_ratio. A value of zero turns this

feature off. By default, the algorithm looks for the tallest peak, which is not a residual

lock solvent peak, and uses its intensity in the signal-to-noise calculation. However, it is

also possible to specify both signal and noise regions. Specifying a signal region can be

very useful if one is looking to run the experiment until a carbonyl carbon appears. The

signal region can be set to look for the carbonyl peak in an anticipated region. On the

Header tab of the experiment window, click . A box similar to Figure 44 should

appear. Click on sn_signal_start, Add, sn_signal_stop, Add, and then Done. Enter a

region where you expect to find the peak of interest (Figure 45). Now when you submit

the experiment, it will run the experiment until it reaches sn_ratio for the peak in the

specified region or scans, whichever comes first. If desired one can use the same

procedure to specify a noise region.
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Figure 44 Adding the signal flags

Figure 45 Adjust these parameters to a suitable region, units must be specified.

Processing

After the data have been transformed, phase the carbon data, and peak pick as usual. For

the DEPT 135, phase the data so that the methyl and methine peaks are “up” and the

methylene peaks are “down”. Make sure that if any manual phasing was done to click

 and to re-process the data. Otherwise, the phase changes will not be transferred to

Data Slate. Drag both data sets to a Data Slate and chose View -> Connect X to connect

the x axes. With the axes connected, zooms will track identically for both data sets.

Assignment Strategy

In quinidine, we know that there are 20 distinct carbons. Therefore, we must count at

least this many carbons in our 1D carbon spectrum to have a correct structure. Remember

that chemically equivalent carbons will show up as one peak, so the number of carbons in

the molecule may not equal the number of carbons counted in the spectrum. If there are

“additional” carbons, one might look for solvent or starting material resonances. In

DEPT135 spectra, both CH3’s and CH’s are usually phased “up” while CH2’s are phased

“down”. Thus, the DEPT135 data in Figure 46 shows that are 11 methyls/methines and 5

methylenes present. Moreover, since quaternary carbons do not appear in DEPT spectra,

the 4 carbons that appear in the 1D carbon, but are absent in the DEPT 135, are assigned

as quaternary carbons. Thus, all the types of carbons expected are present. The DEPT

experiments prove particularly useful for discerning a methine carbon from a methylene
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carbon when chemical shift information is ambiguous and for seeing carbons buried

under residual solvent peaks.

Figure 46 1D carbon and DEPT135 result indicating types or carbons
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DQF-COSY

Purpose: Elucidate proton connectivities

Experiments: /usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/ecp_grad/single_shape/dqf_cosy_pfg_s.exp

Pulse width(s) used: 1H Obs 90

Processing List(s): /usr/delta/global/process_lists/2d_cosy_abs.list

A DQF-COSY (Double Quantum Filtered) experiment is run to assign proton

connectivities. The double quantum filter attenuates singlets such as a water peak or

methoxy peak. Suppression of these types of signals allows one to set a higher receiver

gain than that used in its corresponding proton experiment.

Parameters to set

Run a 1D proton NMR. Note the gain value determined for the proton spectrum. As a

first guess, use this receiver gain in the DQF-COSY experiment. Remember that the

double quantum filter attenuates large singlets so if these types of signals are present, the

receiver gain can be set to a higher value. Zoom the peaks in the proton data so there is

about 0.5[ppm] on either side of the peaks. In the DQF-COSY experiment window, click

 and then . Now click on the zoomed proton data set. The x_offset and

x_sweep will change to reflect the zoomed data set. Turn the spinner off.

Loading High-Resolution Projections in Homonuclear Data

In the nD Processor, click  to send the data to the 2D Viewer. A window resembling

Figure 47 will result. Notice that there are “low-resolution” 1D projections drawn on the

data. These projections are generated from the intensity dimension of the 2D data. It is

common to load “high-resolution” data (i.e. your proton data) into these axes. Click 

in the 2D Viewer to toggle operations from disk to finger mode. Select Display -> High-

Res -> Load X Projection, and then click on the processed proton spectrum. This will

load the proton data set into the x-axis of the viewer. Repeat the procedure using Load Y

Projection. Notice now that the data contained along the axes have “real” filenames.

Upon loading the high-resolution projections, the 1D and 2D data will be automatically

connected. Therefore, any zooming done in either the 1D or 2D portions of the window

will occur in concert. Contour the data, as needed, using the Level Tool. See Appendix D

for a detailed explanation of the Level Tool.
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Figure 47 Loading high-resolution projections

Assignment Strategy

To assign COSY peaks, look for matching cross-peaks off the diagonal. Figure 48 shows

an expansion of the aromatic region of a DQF-COSY spectrum with the coupled aromatic

protons traced out and a structure highlighting these connections. Figure 49 shows the

full spectrum. Note that in the full spectrum, the data is symmetric about the diagonal

drawn.
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Figure 48 Expansion of the aromatic region
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Figure 49 A DQF-COSY spectrum shown with a diagonal
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HMQC

Purpose: Elucidate proton-carbon connectivities

Experiments: /usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/single_pulse_dec.exp

/usr/delta/global/experiments/ecp_grad/single_shape/hmqc_irr_pfg_s.exp

Pulse width(s) used: 1H Obs 90, 13C Decoupling 90

Processing List(s): /usr/delta/global/process_lists/2d_inverse_abs.list

An HMQC (Heteronuclear Multiple Quantum Coherence) experiment is run to assign

proton-carbon connectivities. The HMQC is known as an “inverse” detected experiment

because it detects the more sensitive 1H nucleus instead of 13C. Thus, this experiment is

especially useful if you are sample limited because it will probably require fewer

transients. Moreover, because the experiment filters out 12C-1H peaks, the receiver gain

should be set higher than that used to collect a corresponding proton data set to take

advantage of the inverse detection.

Parameters to set

Run 1D proton and 1D carbon spectra. Set recvr_gain to a sensible value. Remember that

because this experiment suppresses 12C-1H signals, you will need to use a value higher

than used for the 1D proton experiment. Optimize x_offset and x_sweep from the

processed 1D proton data. Do the same for y_offset and y_sweep from the processed 1D

carbon data. Turn the spinner off.

Loading High-Resolution Projections in Heteronuclear Data

In the nD Processor, click  to send the data to the 2D Viewer. Click  in the 2D

Viewer to toggle operations from disk to finger mode. Select Display -> High-Res ->

Load X Projection, and then click on the processed 1D proton spectrum. This will load

the proton data set into the x-axis of the viewer. Repeat the procedure using Load Y

Projection but click instead on the 1D carbon spectrum. Contour the data, as needed,

using the Level Tool. See Appendix D for a detailed explanation of the Level Tool.

Assignment Strategy

The spots seen on an HMQC spectrum can be traced directly to the corresponding 1H and

13C peaks in the high-resolution projections. These correlations show the protons and

carbons that are directly attached to one another. Figure 50 shows an HMQC data set

with correlations for both 12 and 22 traced out. Additionally, a structure highlighting the

connections is also shown.
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Figure 50 An HMQC Spectrum
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HETCOR

Purpose: Elucidate proton-carbon connectivities

Experiments: /usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/single_pulse_dec.exp

/usr/delta/global/experiments/chshf.exp

Pulse width(s) used: 13C Obs 90, 1H Decoupling 90

Processing List(s): /usr/delta/global/process_lists/2d_ch_abs.list

An HETCOR (Heteronuclear Correlation) experiment is run to assign proton-carbon

connectivities. In contrast to the HMQC, a HETCOR detects 13C. Thus, this experiment

will usually require more scans than an HMQC. However, if you are not sample limited,

the HETCOR has the advantage of good resolution in the carbon domain. Note that

“chshf” is the HETCOR experiment.

Parameters to set

Run 1D proton and 1D carbon spectra. Click auto_gain to automatically determine a

receiver gain value. Optimize x_offset and x_sweep from the processed 1D carbon data.

Do the same for y_offset and y_sweep from the processed 1D proton data. Turn the

spinner off.

Processing

In the nD Processor, click  to send the data to the 2D Viewer. Click  in the 2D

Viewer to toggle operations from disk to finger mode. Select Display -> High-Res ->

Load X Projection, and then click on the processed 1D carbon spectrum. This will load

the carbon data set into the x-axis of the viewer. Repeat the procedure using Load Y

Projection but click on the 1D proton data. Contour the data, as needed, using the Level

Tool. See Appendix D for a detailed explanation of the Level Tool.

Assignment Strategy

The spots seen on a HETCOR spectrum can be traced directly to the corresponding 1H

and 13C peaks in the high-resolution projections. These correlations show the protons

and carbons that are directly attached to one another. Figure 51 shows a HETCOR data

set with correlations for both 12 and 22 traced out. Additionally, a structure highlighting

the connections is also shown. Note that the axes on the data set are the reverse of the

HMQC. This difference in axes is not just cosmetic; it can also affect the ultimate data

resolution in x and y. Figure 52 shows an overlay of HETCOR (red) and HMQC (green)

data. Note that to enable the overlay of these data an extra Transpose has to be added to

the y-processing list of one of the data sets. In Figure 52, the HETCOR data more clearly

shows that the two protons buried under the resonance at ~2.88[ppm] are on different

carbons. The reason that the carbon resolution may be better in the HETCOR than in the

HMQC is because you are dividing the wider carbon spectral width by more data points
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in the carbon-detected experiment. This is because the directly detected domain always

contains more data points. This does not mean that HETCOR should always be preferred

over inverse-type experiments, but rather that one has to be aware of setting the

conditions

Figure 51 A HETCOR spectrum, the box corresponds to the expansion in Figure 52
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Figure 52 Expansion comparing HETCOR and HMQC
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Edited HSQC

Purpose: Elucidate proton-carbon connectivities and multiplicity of carbons

Experiments: /usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/single_pulse_dec.exp

/usr/delta/global/experiments/multiplicity_hsqc_pfg_s_phase_pn.exp

Pulse width(s) used: 1H Obs 90, 13C Decoupling 90

Processing List(s): /usr/delta/global/process_lists/2d_inverse_phase.list

An HSQC (Heteronuclear Single Quantum Coherence) spectrum is run to assign proton-

carbon connectivities. The HSQC is known as an “inverse” detected experiment because

it detects the more sensitive 1H instead of 13C. The phase sensitive version shown here

also affords information similar to a DEPT 135, in that one can identify the multiplicities

of the carbons from the peak phase.

Parameters to set

Run 1D proton and 1D carbon spectra. Set recvr_gain to a sensible value. Remember that

because this experiment suppresses 12C-1H signals, you will need to use a value higher

than used for the 1D proton experiment. Optimize x_offset and x_sweep from the

processed 1D proton data. Do the same for y_offset and y_sweep from the processed 1D

carbon data. Turn the spinner off.

Phasing 2D Data

In the nD Processor, click  to send the data to the 2D Phaser (if you are processing

an FID, be sure to load in a processing list first!). Using Create cursor, drop some

cursors along the data, on the peaks you wish to phase. The cursors will mark where the

data will be sliced (Figure 53). Click . The window will now show you

the slices you selected. Phase the data with the p0 and p1 buttons provided (Figure 54).

You may find it easier to phase one dimension at a time. That is, phase one axis, apply

the phase and then drop cursors again to phase the next dimension. Click  to apply

any phase changes. If you are happy with the phasing click  to send the data to the 2D

Viewer. Load the high-resolution projections. You need to load the 1D proton with Load

X Projection and the 1D carbon with Load Y Projection. Contour the data, as needed,

using the Level Tool. See Appendix D for a detailed explanation of the Level Tool.
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Figure 53 Dropping cursors in the 2D Phaser

Figure 54 Data after phasing in the 2D Phaser
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Assignment Strategy

The spots seen on an HSQC spectrum can be traced directly to the corresponding 1H and

13C peaks in the high-resolution projections. These correlations show the protons and

carbons that are directly attached to one another. Additionally, in this Edited HSQC

spectrum, the phase affords multiplicity information analogous to the DEPT 135

experiment. In Figure 55, the contours have been colored green and red, marking the

positive and negative contours, respectively. The positive contours correspond to methyl

and methine carbons, whereas the negative contours correspond to methylene carbons. In

the figure, the correlations for both 12 and 22 are traced out. Additionally, a structure

highlighting the connections is also shown. Note also that in the figure, both the 1D

carbon and DEPT 135 data have been loaded on the y-axis for emphasis. To accomplish

this, the carbon was loaded into the high-resolution projection while the DEPT135 was

loaded into the high-resolution slice.

Figure 55 Edited HSQC spectrum
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1H-15N Correlations with HMQC

Purpose: Elucidate proton-nitrogen connectivities

Experiments: /usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/ecp_grad/single_shape/hmqc_irr_pfg_s.exp

Pulsewidth(s) used: 1H Obs 90, 15N Obs 90, 15N Decoupling 90

Processing List(s): /usr/delta/global/process_lists/2d_hmbc_abs.list

An HMQC spectrum is usually run to assign proton-carbon connectivities. However, by

choosing a different j_constant and changing the y_domain to nitrogen, on can get a 1H-
15N correlation. This “inverse” experiment is especially useful because it observes the

much more sensitive proton nucleus instead of nitrogen, which in practice is hard to

observe directly. Detecting the nitrogen indirectly then affords a great time savings over a

direct observe 1D nitrogen experiment. Additionally, the experiment gives long-range
1H-15N correlations that can be used to unambiguously assign the nitrogens without

consulting a chemical shift table.

Parameters to set

The recvr_gain will need to be set to a large value. Optimize x_offset and x_sweep from

the 1D proton data. Set y_offset and y_sweep to a range appropriate for your compound.

You may need to consult a chemical shift table to set this range. Set scans. Change

y_domain to Nitrogen15. Note that the correct pulse widths and gradient ratios are parsed

into the experiment window automatically when you select the 15N domain. If you do not

have an auto tune probe make sure you check the box for force_tune in the top of the

experiment window. You will be prompted to tune the LF and HF channel by hand after

you submit the experiment. Set j_constant to a value appropriate for your compound. In

this example, a 2,3J constant of 6[Hz] was used. Turn the spinner off.

Processing

Click  to send the data to the 2D Viewer. Note that a Notch Filter was added to the

processing list in X to take out the methoxy ridge. Load the 1D proton data with Load X

Projection. Contour the data, as needed, using the Level Tool. See Appendix D for a

detailed explanation of the Level Tool.

Assignment Strategy

One can read off the correlations exactly as in an HMQC or HSQC data set. The only

difference is that in this data, the positions of the nitrogen peaks are read off from the

low-resolution y-projection and not from a high-resolution 1D data set. Figure 56 shows

that two different nitrogens are seen as was expected from the structure. A structure

highlighting the correlations is also shown in the figure. Note that the correlations seen in

this type of experiment are highly dependent on the magnitude of the j_constant used.
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Figure 56 1H-15N HMQC spectrum
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HMBC

Purpose: Elucidate long-range proton-carbon connectivities

Experiments: /usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/single_pulse_dec.exp

/usr/delta/global/experiments/ecp_grad/single_shape/hmbc_pfg_s.exp

Pulsewidth(s) used: 1H Obs 90, 13C Obs 90

Processing List(s): /usr/delta/global/process_lists/2d_hmbc_abs.list

The HMBC (Heteronuclear Multiple Bond Correlation) experiment is designed to give

long-range 2,3J(C,H) proton-carbon connectivities. An HMBC data set is useful for

assigning quaternary carbons and as a “check”that other correlations have been assigned

correctly.

Parameters to set

Set the recvr_gain to a sensible value. Remember that because this experiment

suppresses 12C-1H signals, you will need to use a value higher than that used for the

correponding 1D proton experiment. Optimize x_offset and x_sweep from the processed

1D proton data. Do the same for y_offset and y_sweep from the processed 1D carbon

data. Turn the spinner off. The default setting for long_range_j can be modified if

needed.

Processing

Click  to send the data to the 2D Viewer. Load the 1D proton data with Load X

Projection. Load the 1D carbon data with Load Y Projection. Contour the data, as

needed, using the Level Tool. See Appendix D for a detailed explanation of the Level

Tool.

Assignment Strategy

An HMBC spectrum provides a wealth of information. One can read off the correlations

exactly as in an HSQC or HMQC data set. However, an HMBC will usually give you

many more correlations. Figure 57 shows an HMBC data set. Figure 58 shows one “strip”

of the data at H12 and also shows a structure highlighting the correlations. Note

especially that correlations to quaternary carbons 10, 11 and 13 are seen. The HMBC

pulse sequence is designed to give long-range correlations and suppress single bond

correlations. However, if single bond correlations do break through, they appear as

doublets. Some breakthrough correlations are indicated in Figure 59. This figure has the

HMBC data (green) overlaid on top of HSQC data (red).
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Figure 57 An HMBC spectrum, the box corresponds to the expansion in Figure 59

Figure 58 HMBC data show long-range (2,3 J) correlations
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Figure 59 Overlay of HSQC (red) and HMBC (green), break-through single bond correlations are circled
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1D DPFGSE-NOE

Purpose: Elucidate through-space interactions

Experiments: /usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/dpfgse_noe_pfg_s.exp

Pulsewidth(s) used: 1H Obs 90, 1H Selective 90

Processing List(s): /usr/delta/global/process_lists/std_proton_autophase.list

The Double Pulsed Field Gradient Spin Echo experiment has largely supplanted the

traditional difference NOE experiment. This is because it does not produce artifacts

caused by subtraction errors or Bloch-Siegert shifts. Note that this experiment contains a

mix_time. This is because unlike the traditional steady-state difference NOE experiment,

the DPFGSE-NOE experiment produces a transient NOE. The intensity of the

enhancements seen in this experiment is highly dependent on the duration of the mix

time.

Parameters to set

Run a 1D proton experiment first. You will need to set recvr_gain to a value higher than

that used in the 1D proton experiment. Using Copy position to Buffer  from the Pick

cursor, select the peak you wish to irradiate from the proton data set. Move the mouse

into the x_offset field, double-click the right mouse button, and then click the middle

mouse button to paste in the offset value. Set mix_time to a sensible value. Turn the

spinner off.

Processing

Process the 1D proton spectrum as usual. Process and phase the DPFGSE-NOE spectrum

so that the irradiated peak is negative. It is helpful to move both the 1D proton and

DPFGSE-NOE spectrum to a Data Slate and to connect their x-axes.

Assignment Strategy

There are two basic types of structural information gained from NMR data. One type

probes through-bond interactions while the other type probes through space-interactions.

The “NOE” experiments like the 1D DPFGSE-NOE experiment probe through-space

interactions. The NOE effect can be quite weak and falls off precipitously with distance

(~
6

1

r
 where r is inter-atomic distance). Since one is investigating through-space

interactions, it is very useful to make a model to use when deciding which protons to

irradiate and when trying to interpret results. This experiment is especially useful for

assigning diastereotopic protons. In the example, the peaks thought to be 14 and 14' were

irradiated. Since the peak irriadiated at ~2.1[ppm] shows an enhancement to 21 and the
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peak irradiated at 1.16 [ppm] does not, the peak at ~2.1[ppm] must be 14'. This is because

only the proton closer to 21 should show a correlation (see Figure 60).

CH3 O

N

H

OH

N

H

H

CH2

H

Figure 60 A 1D NOE-DPFGSE experiment, the *’s indicate where peaks were irradiated

*

*
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*
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14´
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• irradiated at 1.14 ppm

• irradiated at 2.00ppm

• proton spectrum
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ROESY

Purpose: Elucidate through-space interactions

Experiments: /usr/delta/global/experiments/single_pulse.exp

/usr/delta/global/experiments/roesy/t_roesy_phase.exp

Pulsewidth(s) used: 1H Obs 90

Processing List(s): /usr/delta/global/process_lists/2d_homo2d_phase.list

It is often useful to run a two-dimensional NOE experiment. This is because one can

obtain correlations for all protons in one experiment. The ROESY (Rotating frame

Overhauser Effect Spectroscopy) is a good candidate for small molecules. This is because

for compounds with molar masses ~1000–3000, cross signals can disappear due to the

fact that the NOE effect modulates as a function of molecular correlation time.

Parameters to set

Run a 1D proton first. Use the receiver_gain for the ROESY experiment. Optimize

x_offset and x_sweep from the processed 1D proton data. Set x_spinlock_atn so that the

spinlock_strength is sufficient to cover the desired bandwidth. Set an appropriate

mix_time. It is often useful to run several experiments with slightly different mix times.

Turn the spinner off.

Processing

Click  to send the data to the 2D Phaser. Phase the data so that the cross-peaks are

negative and the diagonal peaks are positive. Click  to send the data to the 2D

Viewer. Load the 1D proton data with Load X Projection. Contour the data, as needed,

using the Level Tool. See Appendix D for a detailed explanation of the Level Tool.

Assignment Strategy

As in the 1D NOE experiment, it is very useful to refer to a model of your compound

when trying to make assignments. The NOE correlations will appear with a phase

opposite to that of the diagonal. In Figure 61, the NOE correlations are shown in red,

while the diagonal is shown in green. An expansion of the aliphatic region of the

spectrum is shown in Figure 62.
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Figure 61 A ROESY spectrum
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Figure 62 An expansion of the ROESY spectrum
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IV. Using Preferences… to Customize an Account

There are a number of preferences that can be set to suit a user's taste. These preferences

include whether or not to display certain features (i.e. peak pick, integrals, grid), default

file directories, printer options etc. The default values for all such items are contained in a

text-based file in your home directory on the workstation computer. The advised mode of

altering this file is with the GUI Preferences… tool. In the Delta Console, select File-

>Preferences… After a few moments, the Preferences… tool will appear (Figure 63). At

the top of this tool are twelve icons that select the different "pages" within the tool.

Because there are a large number of Preferences, it is usually best to find an individual

preference using the Options-> Search… function within this tool. In Figure 64, a search

was performed on integrals. If a preference is selected in the Search Tool, the

Preferences… tool will change to the appropriate page and be highlighted in yellow

(Figure 63).

Figure 63 Preferences? tool found in the Delta Console

Figure 64 Search Tool contained in the Preferences? Tool
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V. File Management

Setting default paths with the Preferences… Tool

The default paths for data , as well as all other default paths, can be modified using the

Preferences… tool. The paths are available on the Directory tab. Click  to access this

Figure 65 The Directory tab

Tab (Figure 65). Keep in mind that the directory you choose must already exist. One can browse currently

available directories by clicking .

Using File Manager

In addition to the operating system’s file management tools, Delta provides the File

Manager. This tool provides additional functionality specific to NMR data files. To start

the tool, click  from the Master Console. The tool in Figure 66 should appear.
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Figure 66 File Manager tool

Deleting Processed Data with File Manager

It is common to keep raw NMR data (i.e. the FID) and to discard processed NMR data.

The File Manager provides a convenient way of doing this. The first step is to move to

the directory containing your data. Click on Select Directory…and choose Data. Click

the filename on which to operate. With this filename highlighted, choose Data -> Purge

Processed. The Purge Options box should appear (Figure 67). This window allows you

to purge the currently selected files, files in the current directory or all the files in all the

user's subdirectories. The only extensions remaining after this action will have units of

[s].

Figure 67 Purge file options
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Performing a File Search with File Manager

The File Manager has the capability of performing very detailed searches for NMR files.

To initiate a search in the File Manger, as well as in other Delta tools, click . The

window in Figure 68 should appear. Click any desired boxes and adjust the Booleans as

necessary. Click  to initiate the search. The example in the figure searches

Figure 68 Performing a search for NMR data files

for all FID with a mix_time of 0.5[s]. The result of this search is shown in Figure 69. To

view a file, select it with the mouse and then click on the desired viewer at the bottom of

the tool. Alternatively, one can drag files out to the desktop with right-mouse-button drag

and drop.
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Figure 69 Click on a viewer or drag file onto the desktop

Comparing Files with File Information

In addition to searching on parameters, it is also possible in Delta to directly compare two

data files’ parameters. Click Master Console -> , which is the open data icon.

Choose a filename and extension and then click . A new window will display

the parameters for that file. You can change  to All to see all the parameters. To

compare another data sets parameters, choose File -> Compare…. Select another

filename and extension. The second file and its parameters will then be displayed in the

same window (Figure 70). Any parameters common to the two data files will be

displayed in black. Parameters common to the two data files, which have different values,

will be displayed in red. Parameters that are unique to a data file will be displayed in

green.
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Figure 70 Comparing two files using File Information

VI. Shutting Down/Starting up Your System

Eventually it will be necessary for you to shut down and restart your system. For

example, you might learn that your physical plant is scheduling a power shutdown. The

following procedures may be used.

Shut Down

If you are connected to the spectrometer, select Unlink from the Spectrometer Control

tool. This will stop communication between the workstation and acquisition system.

Next, turn off the power to the console using the main power switch located on the front

of the console. Shut down the workstation. Note that it is not usually necessary to shut

down the workstation for a system reboot. However, it should be shut down if you expect

a power outage. Turn off the monitor and printer. The system is now completely shut

down.

Start-up

Turn on the workstation, monitor and printer. Login to an account set up to run Delta.

Launch Delta. Turn on the power to the console using the main power switch. Return to

the workstation and monitor the comments in the Delta console. When everything has
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powered up correctly, you should see "Instrument Ready" in the Master Console. You

can now connect to a spectrometer by clicking on the magnet icon.

Restarting Control Only

If a problem arises in the operation of the spectrometer, it is often not necessary to do a

complete system shutdown and restart to remedy the problem. Rather, it is usually only

necessary to restart the program that controls the spectrometer. The name of this program

is “control” and it runs on the acquisition computer. Click  to disconnect from the

spectrometer. On a Windows system, open a command prompt. Then type the

following&:

telnet eclipse2 <ENTER>

root <ENTER>

supply the password <ENTER>

cd /eclipse/ <ENTER>

./stop <ENTER>

wait a few seconds …

./start <ENTER>

You will notice that the spectrometer will go through its boot sequence.

On a Mac Or Linux workstation, open a UNIX shell and type the following:

eclipse1$ rlogin -l root eclipse2 <ENTER>

supply the password <ENTER>

cd /eclipse/ <ENTER>

./stop <ENTER>

wait a few seconds …

./start <ENTER>

You will notice that the spectrometer will go through its boot sequence.
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VII. NMR System Backup/Restore with Delta Spectrometer Backup

There are a number of spectrometer specific files that reside on the acquisition computer.

To back these files up, it is possible to do the following:

Windows/Mac

Workstations running either WINDOWS XP or OSX use a graphical backup tool. On

windows systems, this tool resides in:

C:\Program Files\JEOL\Delta\bin\Delta Spectrometer Backup.exe

To run the backup tool (Figure 71), double-click  and follow the prompts.

Figure 71 The graphical back/restore tool on Windows

On a Mac, this tool resides in Applications -> Delta Utilities. Double-click  and then

follow the prompts.

Linux

On Linux based workstations, you need to run the backup tool from the command line.

To do this, type the following in a UNIX shell:

Note: this assumes the name of your spectrometer is eclipse2

./backup_spectrometer eclipse2 <ENTER>

Give the root password for the acquisition computer <ENTER>

This will create a directory called back_eclispe2 containing the spectrometer files.

Alternaytively, one can use the cd_backup script provided on the workstation. To run this

script, you need to first log into the root account. Open a UNIX shell. At the prompt,

type:

./cd_backup  ENTER
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Follow the instructions as prompted. If you would like to backup the workstation only, be

sure and type n when asked if you want to copy spectrometer files. Upon completion of

the backup, remove the CD, label it and store it in a safe place. Note that this procedure

does not backup any NMR data!

VIII. Cryogen Filling

The most important maintenance procedure for a superconducting magnet system is to

keep the cryostat adequately filled with cryogens. This section gives an OVERVIEW of

how to fill both liquid nitrogen and liquid helium on JEOL NMR systems. This section

assumes you are somewhat familiar with cryogen fills and that you know how to safely

handle cryogenic liquids and compressed gases. If there are any doubts about how to

perform these procedures, contact JEOL for advice before attempting a fill! For filling

schedules and cryogen volumes for your particular magnet, consult the white Oxford#

binder that came with your instrument.

Cryogen Sensors

Most ECX/ECA NMR systems are equipped with both liquid nitrogen and liquid helium

sensors. It is important to remember that these sensors can at times give erroneous results.

This is because if moisture or air was introduced into the system during a previous fill, an

ice block can form on the sensor. It is therefore recommended to fill cryogens by the

calendar and not solely by the reading from a sensor. It is helpful to keep a logbook of

cryogen fills, especially helium fills, to ensure that you know when it is time to fill.

Additionally, a log file of cryogen sensor readings is stored on the acquisition computer

in /usr/eclipse/cryogen.log. This file can be viewed graphically, and plotted, by

selecting Tools-> View Log Files -> View Cryogen Log from the Spectrometer Control

tool.

Nitrogen fills

Be sure to order a low-pressure nitrogen dewar (! 22 p.s.i.) for fills. Using a

high-pressure transfer dewar can cause irreparable damage to the cryostat!

Do not leave the magnet unattended when performing a nitrogen fill!

Performing a nitrogen fill is a relatively straightforward task and should be done once a

week, every week. It is recommended to choose a day of the week that is not subject to

holidays (i.e. not a Monday or a Friday). A nitrogen transfer line can be purchased or

constructed using rubber or silicone tubing. Under no circumstances should

polyethylene/terphthalate tubing be used. Significant injury can result if this type of

tubing breaks at liquid nitrogen temperature. When starting the fill, start slowly until you

are sure you are transferring liquid. The fill rate may then be sped up. The fill is

completed when liquid nitrogen spews out of the exit port. If the nitrogen continues to

surge out of the exit hose after the transfer is stopped, the dewar has been slightly

pressurized. This pressurization can be caused by either filling to fast or because their is a
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blockage in the nitrogen inlet or outlet. For advice concerning this, please contact JEOL

Applications or Service. Finally, care should be taken not to spill nitrogen onto the base

of the cryostat. Prolonged exposure to cryogens at the base of the magnet can cause a

vacuum seal failure.

Helium fills

Note: It is recommended to fill nitrogen before you do a helium fill. This minimizes

atmospheric backflow into the nitrogen during the helium fill.

Do not leave the magnet unattended when performing a helium fill!

Helium fills are much more demanding than nitrogen fills and should be performed only

by experienced personnel. However, the basic concept behind a helium fill is simple. You

want to introduce liquid helium only into the cryostat. Liquid helium is pushed out of the

helium transfer dewar by a tank of gaseous helium. The gaseous helium should be very

pure - no less than 99.997% or U.S. Bureau of Mines Grade A. Remember that

compressed gas cylinders are usually magnetic! Keep the tank of helium gas well outside

the 5 Gauss line to avoid interaction with the magnet. To help keep room air and moisture

from entering the magnet, it is advised to slightly pressurize the cryostat dewar before

performing a fill. To do this, you need to first get into console mode. Next, open a new

Sample Tool, and under Options choose Helium Fill Charge. This will increase the

polling of the helium sensor to every 4 seconds, hence, the result is more boil-off of

helium and a positive pressure in the dewar. Do this at least five minutes before

performing the fill. Before attempting to insert the transfer line into the magnet, make

sure that it has been pre-cooled and is spewing out liquid. Also, make sure that the

insulated portion of the transfer line does not get appreciably cold or frosty. If it does, the

transfer line may have to be pumped down. Before inserting the transfer line into the

cryostat, you will also need to wipe off any snow that has collected on it and stop the

flow of helium. Once you have inserted the transfer line and have re-started the flow, you

should notice the helium level displayed in charge mode increase to a high level, usually

>90%. This indicates that liquid helium is splashing on the sensor. The helium transfer is

done when the "plume" coming out of the exit port turns into a "flame". Make sure to exit

out of helium charge mode after the fill by closing the Sample Tool. Confirmation that

you have exited charge mode will be reported in the Delta Console. Finally, it is also a

good idea to recheck the tightness of the bung and exhaust valve after they have re-

equilibrated to ambient temperature. To check how much liquid is available in a transfer

dewar (before or after a fill), it can be "thumped". This procedure uses the "thumper" tube

that has a thin rubber membrane on one end. You can make a membrane by fastening a

portion of a latex glove on the end with a rubber band. Starting from the bottom of the

dewar, a mark can be made on the thumper with a wire tie. Then, if the thumper is raised

slowly, you will eventually notice the frequency of vibration felt at the rubber membrane

will change. Make a mark at this point with another wire tie. If you measure the distance

between the wire ties, you can determine the volume of cryogen in the transfer dewar.

See Appendix C or the table provided with your dewar to convert the distance into liters

of liquid helium.
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Appendix A Shimming the Non-Spin Shims

The following procedure outlines a method for shimming the non-spin shims. The shims

listed here may not correspond exactly to your shim set. It should be noted that many

variations on this procedure are possible.

1) Shim Z1-Z2.

2) Turn off the spinner.

3) Shim X and Y

4) Shim XZ, YZ. If an improvement is made, re-shim X and Y.

5) Shim X2, Y2. If an improvement is made, re-shim X and Y.

6) Shim XZ2, YZ2. If an improvement is made, re-shim X and Y.

7) Shim X2Z, Y2Z. If an improvement is made, re-shim X and Y.

   8) Turn the spin on. Shim Z1, Z2.

 9) Go to step 2.

Repeat this procedure until no further improvement is observed.
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Appendix B Preparing the System for Gradient Shimming

Deuterium Grad Shim Pulsewidth 90

Purpose: Determine the deuterium gradient shim 90° pulse width

Sample needed: 5% CHCl3 with Cr(acac)3 in acetone d-6

Instrument preparation: Shim the probe to the sample

Experiment used: /usr/delta/global/experiments/gradient_shim/single_pulse_2h.exp

Process list used: /usr/delta/global/process_lists/std_carbon.list

Note: This pulse width is normally measured only once. The initial value can be used for the life

of the instrument.

On the Header tab, click  auto_gain and then Done. Uncheck auto_gain. Next to

where it says process, click Edit, Process_Ndimensional and then Accept. Uncheck

automatic. Set recvr_gain to 20. Set x_angle to 90[deg]. Make sure that x_atn is set to at

least 10[dB]. Submit the experiment. Process the data and copy the offset of the

deuterium peak into x_offset. Array x_90_width from 50[us] to 0.8[ms] in steps of

50[us]. Set relaxation_delay to 15[s]. Submit the experiment. Process the result and find

your best null. Divide the null by two to get the 2H obs 90. Figure 72 shows a typical

result. Figure 73 highlights where to save your pulse width and attenuator values in the

Probe Tool.
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Figure 72 2H Gradient Shim Pulse Width

Figure 73 Change the highlighted values to save the 2H Gradient Shim Pulse Width
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Generating 2H Gradient Shimming Basis Sets

Purpose: Collect gradient basis sets (calibration maps)

Sample needed: 1% CHCl3 in acetone d-6 “lineshape sample”

Instrument preparation: Roughly shim the probe to the sample

Purpose: Collect gradient basis sets (calibration maps)

Sample needed: 1% CHCl3 in acetone d-6 “lineshape sample”

Instrument preparation: Roughly shim the probe to the sample

Load the lineshape sample and do a cursory shim, including the non-spin shims. The

shimming does not have to be perfect but one should be sure to shim at least Z1, Z2 and

the non-spin shims. Open Spectrometer Control -> Config -> Gradient Shim Tool. Click

Calibrate. Click Homospoil and 2H (Deuterium). PFG Single should be used for  fields

at 500Mhz and greater. Click on Z1-Z6 next to where it says Excursion. Click NO

DISPLAY so that it says DISPLAY. Click Calibrate. The acquisition of the maps will

take some time. If you need to stop the acquisitions, click on Abort! (Figure 74). When

Figure 74 Click Abort! to terminate gradient shimming events

all of the acquisitions complete, basis sets will appear on the screen. Figure 75 shows a

typical result. Change the units on the maps to be in [%]. One can scroll through the units

by holding down Shift and clicking i on the keyboard. Zoom the Z3 map to display

only the smooth portion of the curve. Zoom the other maps to the same limits. Verify that

this % width leaves no jagged or discontinuous regions in the other maps. If it does,

readjust the width. Read off the % width covered and enter this value into the Gradient

ShimTool where it says % Width. Figure 76 shows the result after zooming the maps.

Gradient shim and run the lineshape test to make sure you are happy with the maps and

the percent width. If the lineshape test is successful, you should save out the percent

width and the gradient basis sets for general use. In the Gradient Shim Tool, click Save

next to where it says % Width. This will store the % width in the gradient configure file.

The gradient configure file and gradient basis sets (z1-z6) should be saved into

/usr/delta/global/instrument, so that all users will have access to these files. It

should be noted that Delta only parses the highest numerical increment for gradient basis

files and that all the files must reflect the current node name. That is, the node names

should be changed if the system is installed on your local network.
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Figure 75 Gradient Basis Sets

Configuring Delta for Gradient Shimming Integration

To complete the gradient shimming configuration process there are some software

modifications one should make. The first is on the acquisition computer. Do an rlogin or

telnet to the acquisition computer and change to the /eclipse subdirectory. Change

machine.pre_exp to correspond to the following example:

eclipse2# cd eclipse/
eclipse2# vi machine.pre_exp
--Default commands executed before a queued experiment
--LOCK_STATE = AUTOLOCK & SHIM
LOCK_STATE = AUTOLOCK
--AUTOSHIM_MODE = Z1 Z2
eclipse2#

Essentially, you need to comment out AUTOSHIM_MODE = Z1 Z2 by adding a double dash

to the line. Modifying machine.pre_exp stops “auto-shimming” from occurring in

automation. Finally, you will need to enable gradient shimming in Preferences…. Select

Master Console -> File -> Preferences… and then click . Change Gradient Shim

Allowed to True. The gradient shim buttons in the Sample Tool should now be activated

(i.e. not “grayed” out).  Also, click  to set the automation preferences. Change both

Gradient Shim and Gradient Shim Allowed to TRUE.
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Appendix C Helium Dewar Levels*

CMSH-30 CMSH-60 CMSH-100 CMSH-250 CMSH-500

Inches Liters Liters Liters Liters Liters

1 0.80 1.00 1.90 4.00 2.00

2 2.80 3.60 3.52 10.00 7.80

3 5.60 7.50  8.46 16.00 17.30

4 8.80 12.10 13.58 22.00 30.40

5 12.10 17.20 18.70 30.00 47.10

6 15.40 22.30 23.82 39.90 65.50

7 18.70 27.50 28.94 49.80 83.80

8 22.00 32.60 34.06 59.70 102.20

9 25.30 37.80 39.18 69.60 120.50

10 28.50 42.90 44.30 79.50 139.00

11 31.30 48.10 49.42 89.40 157.30

12 33.30 53.20 54.54 99.30 175.60

13 34.10 57.80 59.66 109.20 194.00

14 61.70 64.78 119.10 212.30

15 64.30 69.90 129.00 230.70

16 65.30 75.02 138.90 249.10

17 80.14 148.80 267.40

18 85.26 158.70 285.80

19 90.38 168.60 304.10

20 95.50 178.50 322.50

21 100.42 188.40 340.90

22 104.14 198.30 359.20

23 107.68 208.20 377.60

24 218.10 395.90

25 228.00 414.30

26 237.90 432.70

27 245.90 451.00

28 251.90 469.40

29 257.90 487.70

30 261.90 504.40

31 265.90 517.50

32 267.90 527.00

33 532.80

34 534.80

*Note: This table may not be accurate for all dewars
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Appendix D Using the Level Tool

Two-dimensional NMR data has a third dimension corresponding to the intensity of the

peaks. To represent this dimension on a two-dimensional plot “contours” are drawn

similar to a relief map. The Level Tool is a powerful tool for contouring NMR data. It can

be invoked by holding down the right mouse button on a data set. The hot key for

invoking the Level Tool is the \ key. A diagram of the Level Tool and its features is

shown in Figure 76. The left-most buttons represent the 24 positive and negative

Figure 76 Understanding the Level Tool

contours, which can be drawn to represent the data. If the Level Tool apears blank, or the

data does not respond to changes, make sure the data set of interest is selected by clicking

on it with the Page Up key. If a tile is colored and depressed, it has been calculated and is

being drawn on the screen. Once tiles have been calculated, they may be turned on and

off interactively. The contour level distribution can be changed by adjusting the bias

slider. If the bias slider is moved all the way up, the contour distribution will be weighted

to draw more slices near the bottom of the peaks. Conversely, if the bias slider is moved

all the way down, it will draw more slices at the top of the peaks (Figure 77). To see the

changes made by moving the sliders, the Apply button must be clicked to recalculate the

result. If you wish to define a different “bottom” or “top” of the data, it is possible to

change the bounds sliders. Adjusting the bounds sliders can be particularly useful

whenever there is a large intensity difference among the peaks in a data set. For example,

you may wish to create a greater number contours at the base of a group of peaks while

largely excluding the “top” of a very large peak (Figure 78).
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Figure 77  The Bias slider

Figure 78 The Bounds Sliders

To further change the look of contours, single-click-hold the right mouse button the Level

Tool. The menu in Figure 79 will appear. Choose Switch to Colors. The Level Tool will

change to look something like Figure 80. Click on a colored square and either the plus or

minus sign for positive and negative contours, respectively. To apply these changes either
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click  or . To return to the contour portion of the Level Tool, click-

hold the right mouse button and choose Switch to Levels.

Figure 79 The Level Tool menu available from the right mouse button

Figure 80 The Switch to Colors mode of the Level Tool
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Appendix E Maintenance Schedule

The following maintenance schedule is given to roughly outline a timetable for

performing various spectrometer activities. Depending on your site, some of these items

may have to be performed more or less frequently. If there are any questions regarding

spectrometer upkeep and maintenance, contact JEOL for advice.

Weekly

Clean spinner(s) with isopropanol.

Fill Nitrogen.

Monthly

Shim the system to specs and save a new system shim file.

Remove crash and core dump files from user accounts.

As Needed

Calibrate pulse widths.

Fill helium. Time interval depends on the type of magnet at your site. Refer to the white

Oxford! binder for specifics about your system.

Remove the probe to clean.

Backup and purge data files.

Perform Workstation and Acquisition system backup.
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Appendix F Probe Tuning

Minimizing the Signal on the Reflectance Bridge

A probe tune is executed by sending a low power CW signal to the probe. For a probe to

be “tuned” and “matched”, the probe should absorb as much of this power as possible,

and do so as efficiently as possible. One can quantify the goodness of probe tuning by

measuring the amount of power being reflected back from the probe with a reflectance

bridge. The M-console has a series of green LED’s which displays this measurement.

Figure 81 Tuning a probe and the Reflectance Display

When the probe tune experiment is running, the Check LED will be illuminated on the

M-console. If tuning manually, one would then adjust the tune and match knobs to

minimize the signal on the reflectance bridge display. The minimum you observe should

be fairly sharp and obvious.

Using the Force Tune Flag

By default, if the spectrometer senses that the probe is already tuned to a given nucleus, it

will not try to tune it again if asked to tune to that nucleus. For example, if the last

experiment run on the high-frequency coil was proton, and you ask it to tune to proton, it

will indicate that it is not necessary to tune the probe. The Force Tune flag is used to tell

the spectrometer to continue with a probe tune, regardless of its last tuned state. Click the

box, next to where is says Force Tune, before executing an experiment. When the

experiment is submitted, auto-tune probes will start the tuning process. If you are using a

manually tuned probe, you will be prompted to tune. This prompt will include the starting

tune and match numbers and appropriate capacitor stick (if needed). Figure 81 shows an

example of what you would see when tuning to phosphorus. Click  when you are

finished tuning.

Low Power CW

Reflected

Forward
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Figure 81 The probe tuning dialog box


